


Passport to EMEA — Expo Dinner Reception — TODAY

PASSPORT
TO EMEA

1. Fill out the contact information below

2. Visit 12 {or more) OSlsoft Partner Booths and
collect a sticker at each of them. You MUST
collect 12 different stickers.

3. Hand the card in at the main registration
desk to be entered to win.

NAME:

o“o 91

/(e3);) PASSPORT TO EMEA

HAND IN YOUR COMPLETED CARD AT THE
REGISTRATION DESK BY WEDNESDAY AT 9:00
TO BE ENTERED TO WIN.

COMPANY:

TITLE:

EMAIL:

PHONE:

e« 17:00 — 20:00
 Arora Ballroom
and Foyer
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Our Mission ol . 1-:

Multiple Multiple Multiple

Sensors Assets Plants

Empower people, industries
and communities to
transform their world using
operational data.
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Data Infrastructure for Digital Transformation
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OSlsoft Data Collection Technologies
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Connectivity: Over 450 Interfaces and Connectors
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SAN DVIK

-

~

8,000

EMPLOYEES

SALES IN OVER

130

COUNTRIES

AROUND THE GLOBE

(@ OSlsoft. EMEA USERS CONFERENCE 2017 LONDON #OSISOFTUC ©2017 OSlsoft, LLC



Our Objective — Standardize OEE
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Challenge — Wide Variety of Machines

118

CNC Machines

Sites
5 +

CNC Controllers




Solution — Our System Architecture
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The Role of the Pl System

Connect Standardize Deliver & Store
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Our OEE Dashboard
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Our Next Steps

800 +

CNC Machines

20

Production Units




__ Data Infrastructure
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Operational System of Record

Pl Server 2017

P
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Featuring Pl Server 2017
Randy Chitwood

Vice President - SETPOINT
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@ Establish physical connection
from rack(s) to Pl Server.,
\

9 Launch SETPOINT-to-Pl Adapter S/W
to automatically build AF hierarchy
and map tags...

[ |

MACHINES
-&*

" nd mé
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1 System Explorer Legacy 3
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Expanding the Pl System

10X 100X 10X
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Utilizing Data with Visualization and Analytics
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Next Generation Integrated Visualization

Process monitoring | Ad-hoc analytics | Dashboards | Data entry

it
O Pivision
Related Events

Mine Truck 1 Brake Temp LR 2015.0.
912172015 73327 AM - 91212015 7:3427 AM

Mine Truck 1 Brake Temp LR 2015-0. >
Mine Truck 1 Brake Temp LR 2015-0.>
Mine Truck 1 Brake Temp LR 2015-0.>
Mine Truck 1 Engine RPM 2015-09-2.>
Mine Truck 1 Brake Temp LR 2015-0.>
Mine Truck 1 Brake Temp LR 2015-0. >
Mine Truck 1 Engine RPM 2015-09-2. >
Mine Truck 1 Engine RPM 2015-08-2.>
Mine Truck 1 Engine RPM 2015-09-2.>
Mine Truck 1 Motor 2015-09-21 06:352.
Mine Truck 1 Engine RPM 2015-09-2.>
Mine Truck 1 Payload 2015-09-21 06: >

Attributes

Mine Truck 1 Brake Temp LR 2015-09-21
07:33:27

Asset Performance

[ Ground Speed Avg - 20 652 mith
Brake System

= Brake Excursion Location - Left R
F& Brake Temp Avg - 25525 °F

&= Brake Temp.Max - 255.64 °F
Information

@ Comment

i Description - High Brake Tempera
= Driver - Neil Bardhan

& Operating State - Loading
Payload System

&= Load Avg - 203.34 ton

Tire Monitoring System

= Tire Praceirs Avn - 988 21 nai

Display: Frame Roll

' Frame Roll Analysis

Name & Description
Mine Truck 1 Frame Roll 2015.09.15 10:58.2' Average Pitch

Ming Truck 1 Frame Rol 2015-09-15 10'58:2 Maximum Pich

Mine Truck 1 Frame Roll 2015.09-15 10:55:2° Minimum Pitch

Mine Truck 1 Frame Roll 2015.09.15 10.532° Average Rack (Twisting)
Mine Truck 1 Frame Roll 2015-09-15 10:58:2' Maximum Rack (Twisting)
Mine Truck 1 Frame Roll 2015-09-15 10:53:2 Minimum Rack (Twisting)
Mine Truck 1 Frame Roll 2015-0-15 10.53.2° Average Roll

Mine Truck 1 Frame Roll 2015-09-15 10:58:2' Maximum Rol

Mine Truck 1 Frame Roll 2015-09-15 10:58:2° Minimum Rol

Mine Truck 1 Frame Roll 2015.09-15 10.58.2

Mine_Truck_1

Time series | Events | Assets | Analytics | Notifications

#OSISOFTUC

©2017 OSlsoft, LLC
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Featuring PI Vision 2017
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A2A Company

A2A is the largest Italian multi-utility company, a
leader in the energy, environment, heat and networks
sectors.

Iltalian leader in environmental services &
district heating

« Second-largest domestic producer of energy,
with a product mix geared to renewable
sources

» Second-largest operator in electricity distribution networks

 One of the largest in gas and water cycle networks

P
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Hydroelectric Power Plants:
Managing water...

at a massive scale! ©
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Goal: Manage water flow and energy production

Buy & sell energy Predict & control Closer we are to
onto market power generation target, the better
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How to manage distributed hydro plants when 500 km away?

CHALLENGE

Only local monitoring

(@ OSlsoft. EMEA USERS CONFERENCE 2017 LONDON #OSISOFTUC ©2017 OSlsoft, LLC



Livellodiinvaso{ms.m]

Portata scacicata [m*/s]

HYDRO PLANT PORTAL |

ICTproduzione
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Quickly see all real-time information with Hydro Plant Portal
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Potenza complessiva
421,12 MW

Potenza complessiva: 508,60

ICTproduzions ICTproduzione
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ICTproduzione

1.895,47

0,00
8,9

110,34

T T 1 187.176,95
R\

¢
[ A
Potenza gruppi

Gruppo 1 Gruppo 3
76,30 MW 51,86 MW

ICTproduzione
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Data
Archive

\\

V.

f(x,y,2)

Model Function

Asset
Framework

—

Pl Server

Pl Interface for OPC:
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Benefits

Give all users secure access to Ol
real-time data

No special software on user’'s 02
PC or smart phone

See critical KPIs that
you can trust

Produce energy efficiently to
save water & improve revenue
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Supporting project monitors information communication technology (ICT)

O Pl Vision

(Vi) Monitoring_Home ~ Asset. DCPRVWDD3+ ¥

4 \ i issi SAPP Termo ==
Cassano
O Ve Moenfalcone
b X Gissi T
ki San Filippo 1/2
_ San Filippo 5/6
D at a & Chivasso
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R e " “ Sermide o
Archive o e & .
« O Notifization -
* Ping alert Milano\DCPR . i

) [ g, \ 4 = tification@aa e
CPU Pln { 1 Enri‘l ca IC-I'Ir_Ja aeu

Health Status 2 ¢ vel Data Center

Motifizatian i closed ok AGENTI 1w
Severity: Majar AGENTI 2
StartTime: [4/10/7017 13 30000 NBDO 1
A AF End Time041 052017 123400 ool
u WA A — —_—
v | Meme Macching epbrinita
~ | & Deacrizionz: Brindiai

Ping Rasponse Time: 31ms

A J—I_I_H_U—| Event Valore Limite; 50 ms
i Tempo Limite: 600

Frames Wiew datails in Fl Wision O
Nl 0
: t y v
Events & Pl Server
triggers
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Future plans

Add forecasting data for
 Dam level and flow rates
« Energy predictions

ey

= o
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One VisIC Pl Vision

A unified visua' infrastructure Pumvaerview]ff'-ﬂ

Properties

140, 15 L 1 L " 1 1
3/2/2016 5:29:09 AM 8h 3/2/2016 1:29:09 PM
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Advanced Integrations — Supported Systems

Visual Analytics Data Warehouse / Data Lake Streaming Analytics — 2017
Excel ©Spotfire’ @ o T H
e TIBCO Software Q 4 a"

@
SAP Busi Objects Microsoft® @ H
SR mm. SQL Server 0T Hub Machine Learning

@ _oves S <% 97
esri | el VA A Spark

i+
“dr+ableauw

g L A PR Stream Analytics
. . . W ’ w
- 0 - Q) N
powerdl| =l 8 @ skafka @
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Featuring PI Integrator for BA

Martin Stanyon
Data and Analytics Manager
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centrica

We are an energy
and services
company

Everything we do is focused on

satisfying the changing needs of our
customers

Bord Gais

0255 pwencss  centrica  BEYSY,  DYNO =HIVE centrica



Centrica Business Solutions centrica

Existing Plant Construction Projects Distributed Energy

Barry Power Station Roosecote 49MW
Battery
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The Challenge centrica
i h

tot. EMEA USERS CONFERENCE ¢« BERLIN, GERMANY
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The Challenge — Monthly Reporting centrica

YL@
YL@
yuLe-
YL@
yuae-
yse-

“If you haven'’t found any typos or mistakes in

the calculations, it may just be a good month,

but it's more likely you just aren’t looking hard
enough ;-) “

11 280 E— 205 436 ﬂ

\ﬁ_)n‘

Lol ot Lol Tl N l.o}
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H S- =RDE- - Thermal Reporting Chec
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H ©- =Rr0OE- - Thermal Reporting Check - Excel Stanyon, Martin B

File Home Insert Page Layout Formulas Data Review View Developer PI Datalink Pl Builder Power Pivot DataGenic Q Tell me what you wan

AT & f || =A8-A4 o
A B c D E F G H | J -

7 42248 |Metered Active HH | Electrical Export  Electrical Import ~ Tag not found Gas Volume Tag not found Lower CV Tag not found Higher CV
135 03/09/2015 16:00 -1.200000048 0 0 0 0 35627998357 35.62799835 39.47999954 39.479
136 03/09/2015 16:30 -1.179999948 0 0 0 0 35.61999893" 35.61999893 39.47100067 39.471
137 03/09/2015 17:00 -1.149999976 0 0 0 0 35.57500076" 35.57500076 39.42300034 39.423
138 03/09/2015 17:30 -1.159999967 0 0 0 0 35576000217 35.57600021 39.42399979 39.423
139 03/09/2015 18:00 -1.149999976 0 0 0 0 35.39300156" 35.39300156 39.22700119 39.227
140 03/09/2015 18:30 -1.149999976 0 0 0 0 35.32099915" 35.32099915 39.15000153 39.150
141 03/09/2015 19:00 -1.149999976 0 0 0 0 35.34899902" 35.34899902 39.18099976 39.180
142 03/09/2015 19:30 -1.149999976 0 0 2 a EY- VT YV PPVY 4 25.34500122 39.17599869 39.175
143 03/09/2015 20:00 -1.149999976 0 0 5.35100174 39.18299866 39.182
144 03/09/2015 20:30 -1.149999976 0 0 35.3390007 39.16999817 39.169
145 03/09/2015 21:00 250 250 0 7.47999954 39.3219986 39.321
146 03/09/2015 21:30 250 250 0 1,521 Hard'COded 5.57400131 39.42300034 39.423
147 03/09/2015 22:00 -1.149999976 0 0 ».60699844 39.45899963 39.458
148 03/09/2015 22:30 -1.149999976 0 0 CG"S' 7.60699844 39.45899963 39.458
149 03/09/2015 23:00 -1.149999976 0 0 7.58499908 39.43500137 39.435
150 03/09/2015 23:30 -1.149999976 0 0 5.61600113 39.4679985 39.46
151 04/09/2015 00:00 -1.149999976 0 0 .61800003 39.47100067 39.471
152 04/09/2015 00:30 -1.149999976 0 0 0 0 35.61500168" 35.61500168 39.46699905 39.466
153 04/09/2015 01:00 -1.149999976 0 0 0 0 35.61999893" 35.61999893 39.47299957 39.472
154 04/09/2015 01:30 -1.149999976 0 0 0 0 35616001137 35.61600113 39.4679985 39.46
155 04/09/2015 02:00 -1.149999976 0 0 0 0 35.60699844" 35.60699844 39.45800018 39.458
156 04/09/2015 02:30 -1.149999976 0 0 0 0 35.61600113" 35.61600113 39.46900177 39.469
157 04/09/2015 03:00 -1.149999976 0 0 0 0 35.61999893" 35.61999893 39.47299957 39.472
158 04/09/2015 03:30 -1.149999976 0 0 0 0 35.61700058" 35.61700058 39.47100067 39.471
159 04/09/2015 04:00 -1.149999976 0 0 0 0 35.6230011" 35.6230011 39.47800064 39.478
160 04/09/2015 04:30 -1.149999976 0 0 0 0 35.6230011" 35.6230011 39.47900009 39.479
161 04/09/2015 05:00 -1.149999976 0 0 0 0 35.62400055" 35.62400055 39.47900009 39.479
162 04/09/2015 05:30 -1.149999976 0 0 0 0 35.594001??: 35.59400177 39.4469986 39.44
T [ omsumay Lpimpt | @ ° ° ° T e et S e h

Ready Calculate ] H [ 1 +
(b * ©2017 OSIS0




That'’s not all centrica

Pl is only one data source
L ®

Uneven spacing
Out-of-range values
Different start times
Communication failure
and more...

salesforce

Challenge
Join operational data
with relational data

B Microsoft

SQL Server 2016
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That'’s not all centrica

Pl is only one data source Our Businesses Change

i

NSoLof

? -

BE Microsoft

salesforce

SQL Server 2016

ALY

\—H.L‘!Bcﬁﬁ.—
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The Solution — Data Preparation centrica

Source Contextualize Find the data

1

(@ OSlsoft. EMEA USERS CONFERENCE 2017 LONDON #OSISOFTUC ©2017 OSlsoft, LLC



Thermal

Select Data > Modify View > Publish

) Source Assets

Server Production-AF
Database Centrica Energy
[ Asseis

4 ) Power Generation
@ Market Data
» (D) Power Purchase Agreement
» e Renewables
4 [ Thermal

4 @ BanyEY)

‘ 4 ) GPMS Data

€0 Barry GPMS
@ Thermal Reporting

» [ Brigg (BG)
» £ Kings Lynn (KN)
» ) Langage (LE)
» () Peterborough (PH)
» £ South Humber Bank 1{SHB1)
» () South Humber Bank 2 (SHB2)

» [ Trading

anyonm £k

Attributes ‘ Filter

D select Al

E AR
4 PNPlan

4 Reactive Power

4 Seconds Remaining
0 SEL

5L

& Target Active Power

T Search Shape + Matches
TuAsset Shape Found 7 Matches
2] 4 [ Thermal Station s » @ Banry (BY)
4 (QGPMS Data # x| »@oerg e
# Active Power # x| D Kings Lynn (KN
& FR Mode # % | »DLangage(Lg)
4 Frequency SR » @ Peterborough (PH)
& MEL a3 > @ South Humber Bank 1 (SHB1}
# ML # % | » @ south Humber Bank 2 (SHB2)
# PN Modified a1
II 4 PN Plan ]
|
Edit Filters
1 Asset Name
| Barry (BY) ‘
Asset Template
‘ Thermal Station ‘
[] Asset Category

‘ Thermal

(#) Add Filter

Save




The Solution — Bringing it all together centrica

COMBINE &
DATA SOURCE PREPARE ANALYSE PUBLISH & SHARE

@ —o—

Pl Integrator for ."'

Business Analytics

salesforce
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The Solution — Output centrica
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Fuel Burn &
Efficiency
Delivery Factor
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AN s Visust ool Sy estop

What’s next? centrica

UK Market Analysis

L] L]
. .
1
= . E
L P
£2

— e .  a

~

Plant Running
Tracking
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Advanced Integrations — Supported Systems

Visual Analytics Data Warehouse / Data Lake Streaming Analytics — 2017
Excel ©Spotfire’ @ o T H
e TIBCO Software Q 4 a"

@
SAP Busi Objects Microsoft® @ H
SR mm. SQL Server 0T Hub Machine Learning

@ _oves S <% 97
esri | el VA A Spark

i+
“dr+ableauw

g L A PR Stream Analytics
. . . W ’ w
- 0 - Q) N
powerdl| =l 8 @ skafka @
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Data Infrastructure for Digital Transformation

(|
5

Big Data Analytics Cloud
-

@OSISOH“’- Infrastructure |

a0 |
% ) -
mm 2oy
Sensors Devices Assets

( Py N
centrica
_ Pl Integrator for BA

N
'
(s‘f id2a
L PI1 Vision 2017 y

[

@ Briiel & Kjar Vibro

Pl Server 2017

]

[

SANDVIK

Pl Connectors

]

P
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Our Mission ol . 1-:

Multiple Multiple Multiple

Sensors Assets Plants

Empower people, industries
and communities to
transform their world using
operational data.
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Merci

Thank You

Gracias

b ES

Cnacunbo Obrigado




Ray Hall

* rhall@osisoft.com
* VP, Engineering
 OSlsoft, LLC
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Lunch Locations:

Arora / Market Brasserie
Main Lunch All Reserved
Plus Industry Lunch Tables
Reserved Tables & Meetings
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Wednesday

OSlsoft.

TUBE CHALLENGE
LONDON

ALL ACCESS
BUS PASS

Wednesday, October 18th

OSilsoft Street Feast London
— Hawker House

Bus Departures are from the

Intercontinental Hotel ONLY

Meet in the Registration Foyer at the Intercontinental
Hotel for one of the following bus departure times:

e 17:45 ® 18:20
® 18:00 ® 18:30
® 18:10

Return buses begin at 21:00 = 1:00 and will make stops
at the Canary Wharf Tube Station and the
North Greenwich Tube Station.

Pick up your card

OSlsoft.

TUBE CHALLENGE
LONDON

Wednesday, October 18th
OSlsoft Street Feast London
— Hawker House
Meeting times at the Canary Wharf Tube Station =
Look for our guides with signs!
® 18:00 e 1815 * 18:30
GOING ON YOUR OWN FROM CANARY WHARF?
- Take the Jubilee Line towards Stanmore
- 1stop, get off at Canada Water

- Exit station and follow the signs and our guides
to the Hawker House

Don't forget your Oyster card!

Return buses begin at 21:00 — 1:00 and will make stops
at the Canary Wharf Tube Station and the North Greenwich
Tube Station. OR, you can take the tube on your own.

OFFSITE — Buses vs. Tube

OSlsoft.

TUBE CHALLENGE
LONDON

Wednesday, October 18th
OSlsoft Street Feast London
— Hawker House
Meeting times for the Registration Desk
= Intercontinental Hotel O2
® 17:45 ¢ 18:00 o 1815 e 18:30

GOING ON YOUR OWN FROM NORTH GREENWICH?
- Take the Jubilee Line towards Stanmore
- 2 stops, get off at Canada Water
- Exit station and follow the signs and our guides
to the Hawker House
Don't forget your Oyster card!

Return buses begin at 21:00 — 1:00 and will make stops
at the Canary Wharf Tube Station and the North Greenwich
Tube Station. OR, you can take the tube on your own.

of choice at the Registration Desk



OSlsoft.

Pl\Worlo




gg oPsiscif}@\/or\ol

Users Conference - San Francisco 2018

APRIL 23 - 27, 2013







	SETPOINT Keynote (7).pdf
	Slide Number 4

	Binder2.pdf
	SETPOINT Keynote (7).pdf
	Slide Number 5

	Binder1.pdf
	SETPOINT Keynote (7).pdf
	Slide Number 9

	UC17EU-D1KY04-OSIsoft-Hall-Customer-Innovation-Showcases-Latest-and.pdf





